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A business plan is the cornerstone of any successful company, regardless of size or industry. This step-by-step guide provides information on writing a business plan for organizations at any stage, complete with free templates and expert advice. 
Included on this page, you’ll find a step-by-step guide to writing a business plan and a chart to identify which type of business plan you should write . Plus, find information on how a business plan can help grow a business and expert tips on writing one .

What Is a Business Plan?
A business plan is a document that communicates a company’s goals and ambitions, along with the timeline, finances, and methods needed to achieve them. Additionally, it may include a mission statement and details about the specific products or services offered.
A business plan can highlight varying time periods, depending on the stage of your company and its goals. That said, a typical business plan will include the following benchmarks:
	Product goals and deadlines for each month
	Monthly financials for the first two years
	Profit and loss statements for the first three to five years
	Balance sheet projections for the first three to five years

Startups, entrepreneurs, and small businesses all create business plans to use as a guide as their new company progresses. Larger organizations may also create (and update) a business plan to keep high-level goals, financials, and timelines in check.
While you certainly need to have a formalized outline of your business’s goals and finances, creating a business plan can also help you determine a company’s viability, its profitability (including when it will first turn a profit), and how much money you will need from investors. In turn, a business plan has functional value as well: Not only does outlining goals help keep you accountable on a timeline, it can also attract investors in and of itself and, therefore, act as an effective strategy for growth.
For more information, visit our comprehensive guide to writing a strategic plan or download free strategic plan templates . This page focuses on for-profit business plans, but you can read our article with nonprofit business plan templates .
Business Plan Steps
The specific information in your business plan will vary, depending on the needs and goals of your venture, but a typical plan includes the following ordered elements:
	Executive summary
	Description of business
	Market analysis
	Competitive analysis
	Description of organizational management
	Description of product or services
	Marketing plan
	Sales strategy
	Funding details (or request for funding)
	Financial projections

If your plan is particularly long or complicated, consider adding a table of contents or an appendix for reference. For an in-depth description of each step listed above, read “ How to Write a Business Plan Step by Step ” below.
Broadly speaking, your audience includes anyone with a vested interest in your organization. They can include potential and existing investors, as well as customers, internal team members, suppliers, and vendors.
Do I Need a Simple or Detailed Plan?
Your business’s stage and intended audience dictates the level of detail your plan needs. Corporations require a thorough business plan — up to 100 pages. Small businesses or startups should have a concise plan focusing on financials and strategy.
How to Choose the Right Plan for Your Business
In order to identify which type of business plan you need to create, ask: “What do we want the plan to do?” Identify function first, and form will follow.
Use the chart below as a guide for what type of business plan to create:
Is the Order of Your Business Plan Important?
There is no set order for a business plan, with the exception of the executive summary, which should always come first. Beyond that, simply ensure that you organize the plan in a way that makes sense and flows naturally.
The Difference Between Traditional and Lean Business Plans
A traditional business plan follows the standard structure — because these plans encourage detail, they tend to require more work upfront and can run dozens of pages. A Lean business plan is less common and focuses on summarizing critical points for each section. These plans take much less work and typically run one page in length.
In general, you should use a traditional model for a legacy company, a large company, or any business that does not adhere to Lean (or another Agile method ). Use Lean if you expect the company to pivot quickly or if you already employ a Lean strategy with other business operations. Additionally, a Lean business plan can suffice if the document is for internal use only. Stick to a traditional version for investors, as they may be more sensitive to sudden changes or a high degree of built-in flexibility in the plan.
How to Write a Business Plan Step by Step
Writing a strong business plan requires research and attention to detail for each section. Below, you’ll find a 10-step guide to researching and defining each element in the plan.
Step 1: Executive Summary
The executive summary will always be the first section of your business plan. The goal is to answer the following questions:
	What is the vision and mission of the company?
	What are the company’s short- and long-term goals?

See our  roundup of executive summary examples and templates for samples. Read our executive summary guide to learn more about writing one.
Step 2: Description of Business
The goal of this section is to define the realm, scope, and intent of your venture. To do so, answer the following questions as clearly and concisely as possible:
	What business are we in?
	What does our business do?

Step 3: Market Analysis
In this section, provide evidence that you have surveyed and understand the current marketplace, and that your product or service satisfies a niche in the market. To do so, answer these questions:
	Who is our customer? 
	What does that customer value?

Step 4: Competitive Analysis
In many cases, a business plan proposes not a brand-new (or even market-disrupting) venture, but a more competitive version — whether via features, pricing, integrations, etc. — than what is currently available. In this section, answer the following questions to show that your product or service stands to outpace competitors:
	Who is the competition? 
	What do they do best? 
	What is our unique value proposition?

Step 5: Description of Organizational Management
In this section, write an overview of the team members and other key personnel who are integral to success. List roles and responsibilities, and if possible, note the hierarchy or team structure.
Step 6: Description of Products or Services
In this section, clearly define your product or service, as well as all the effort and resources that go into producing it. The strength of your product largely defines the success of your business, so it’s imperative that you take time to test and refine the product before launching into marketing, sales, or funding details.
Questions to answer in this section are as follows:
	What is the product or service?
	How do we produce it, and what resources are necessary for production?

Step 7: Marketing Plan
In this section, define the marketing strategy for your product or service. This doesn’t need to be as fleshed out as a full marketing plan , but it should answer basic questions, such as the following:
	Who is the target market (if different from existing customer base)?
	What channels will you use to reach your target market?
	What resources does your marketing strategy require, and do you have access to them?
	If possible, do you have a rough estimate of timeline and budget?
	How will you measure success?

Step 8: Sales Plan
Write an overview of the sales strategy, including the priorities of each cycle, steps to achieve these goals, and metrics for success. For the purposes of a business plan, this section does not need to be a comprehensive, in-depth sales plan , but can simply outline the high-level objectives and strategies of your sales efforts. 
Start by answering the following questions:
	What is the sales strategy?
	What are the tools and tactics you will use to achieve your goals?
	What are the potential obstacles, and how will you overcome them?
	What is the timeline for sales and turning a profit?
	What are the metrics of success?

Step 9: Funding Details (or Request for Funding)
This section is one of the most critical parts of your business plan, particularly if you are sharing it with investors. You do not need to provide a full financial plan, but you should be able to answer the following questions:
	How much capital do you currently have? How much capital do you need?
	How will you grow the team (onboarding, team structure, training and development)?
	What are your physical needs and constraints (space, equipment, etc.)?

Step 10: Financial Projections
Apart from the fundraising analysis, investors like to see thought-out financial projections for the future. As discussed earlier, depending on the scope and stage of your business, this could be anywhere from one to five years. 
While these projections won’t be exact — and will need to be somewhat flexible — you should be able to gauge the following:
	How and when will the company first generate a profit?
	How will the company maintain profit thereafter?

Business Plan Template

Download Business Plan Template
Microsoft Excel | Smartsheet
This basic business plan template has space for all the traditional elements: an executive summary, product or service details, target audience, marketing and sales strategies, etc. In the finances sections, input your baseline numbers, and the template will automatically calculate projections for sales forecasting, financial statements, and more.
For templates tailored to more specific needs, visit this business plan template roundup or download a fill-in-the-blank business plan template to make things easy. 
If you are looking for a particular template by file type, visit our pages dedicated exclusively to Microsoft Excel , Microsoft Word , and Adobe PDF business plan templates.
How to Write a Simple Business Plan
A simple business plan is a streamlined, lightweight version of the large, traditional model. As opposed to a one-page business plan , which communicates high-level information for quick overviews (such as a stakeholder presentation), a simple business plan can exceed one page.
Below are the steps for creating a generic simple business plan, which are reflected in the template below .
	Write the Executive Summary This section is the same as in the traditional business plan — simply offer an overview of what’s in the business plan, the prospect or core offering, and the short- and long-term goals of the company. 
	Add a Company Overview Document the larger company mission and vision. 
	Provide the Problem and Solution In straightforward terms, define the problem you are attempting to solve with your product or service and how your company will attempt to do it. Think of this section as the gap in the market you are attempting to close.
	Identify the Target Market Who is your company (and its products or services) attempting to reach? If possible, briefly define your buyer personas .
	Write About the Competition In this section, demonstrate your knowledge of the market by listing the current competitors and outlining your competitive advantage.
	Describe Your Product or Service Offerings Get down to brass tacks and define your product or service. What exactly are you selling?
	Outline Your Marketing Tactics Without getting into too much detail, describe your planned marketing initiatives.
	Add a Timeline and the Metrics You Will Use to Measure Success Offer a rough timeline, including milestones and key performance indicators (KPIs) that you will use to measure your progress.
	Include Your Financial Forecasts Write an overview of your financial plan that demonstrates you have done your research and adequate modeling. You can also list key assumptions that go into this forecasting. 
	Identify Your Financing Needs This section is where you will make your funding request. Based on everything in the business plan, list your proposed sources of funding, as well as how you will use it.

Simple Business Plan Template

Download Simple Business Plan Template
Microsoft Excel |  Microsoft Word | Adobe PDF  | Smartsheet
Use this simple business plan template to outline each aspect of your organization, including information about financing and opportunities to seek out further funding. This template is completely customizable to fit the needs of any business, whether it’s a startup or large company.
Read our article offering free simple business plan templates or free 30-60-90-day business plan templates to find more tailored options. You can also explore our collection of one page business templates . 
How to Write a Business Plan for a Lean Startup
A Lean startup business plan is a more Agile approach to a traditional version. The plan focuses more on activities, processes, and relationships (and maintains flexibility in all aspects), rather than on concrete deliverables and timelines.
While there is some overlap between a traditional and a Lean business plan, you can write a Lean plan by following the steps below:
	Add Your Value Proposition Take a streamlined approach to describing your product or service. What is the unique value your startup aims to deliver to customers? Make sure the team is aligned on the core offering and that you can state it in clear, simple language.
	List Your Key Partners List any other businesses you will work with to realize your vision, including external vendors, suppliers, and partners. This section demonstrates that you have thoughtfully considered the resources you can provide internally, identified areas for external assistance, and conducted research to find alternatives.
	Note the Key Activities Describe the key activities of your business, including sourcing, production, marketing, distribution channels, and customer relationships.
	Include Your Key Resources List the critical resources — including personnel, equipment, space, and intellectual property — that will enable you to deliver your unique value.
	Identify Your Customer Relationships and Channels In this section, document how you will reach and build relationships with customers. Provide a high-level map of the customer experience from start to finish, including the spaces in which you will interact with the customer (online, retail, etc.). 
	Detail Your Marketing Channels Describe the marketing methods and communication platforms you will use to identify and nurture your relationships with customers. These could be email, advertising, social media, etc.
	Explain the Cost Structure This section is especially necessary in the early stages of a business. Will you prioritize maximizing value or keeping costs low? List the foundational startup costs and how you will move toward profit over time.
	Share Your Revenue Streams Over time, how will the company make money? Include both the direct product or service purchase, as well as secondary sources of revenue, such as subscriptions, selling advertising space, fundraising, etc.

Lean Business Plan Template for Startups

Download Lean Business Plan Template for Startups
Microsoft Word | Adobe PDF
Startup leaders can use this Lean business plan template to relay the most critical information from a traditional plan. You’ll find all the sections listed above, including spaces for industry and product overviews, cost structure and sources of revenue, and key metrics, and a timeline. The template is completely customizable, so you can edit it to suit the objectives of your Lean startups.
See our wide variety of  startup business plan templates for more options.
How to Write a Business Plan for a Loan
A business plan for a loan, often called a loan proposal , includes many of the same aspects of a traditional business plan, as well as additional financial documents, such as a credit history, a loan request, and a loan repayment plan.
In addition, you may be asked to include personal and business financial statements, a form of collateral, and equity investment information.
Download free financial templates to support your business plan.
Tips for Writing a Business Plan
Outside of including all the key details in your business plan, you have several options to elevate the document for the highest chance of winning funding and other resources. Follow these tips from experts:.
	Keep It Simple: Avner Brodsky , the Co-Founder and CEO of Lezgo Limited, an online marketing company, uses the acronym KISS (keep it short and simple) as a variation on this idea. “The business plan is not a college thesis,” he says. “Just focus on providing the essential information.”
	Do Adequate Research: Michael Dean, the Co-Founder of Pool Research , encourages business leaders to “invest time in research, both internal and external (market, finance, legal etc.). Avoid being overly ambitious or presumptive. Instead, keep everything objective, balanced, and accurate.” Your plan needs to stand on its own, and you must have the data to back up any claims or forecasting you make. As Brodsky explains, “Your business needs to be grounded on the realities of the market in your chosen location. Get the most recent data from authoritative sources so that the figures are vetted by experts and are reliable.”
	Set Clear Goals: Make sure your plan includes clear, time-based goals. “Short-term goals are key to momentum growth and are especially important to identify for new businesses,” advises Dean.
	Know (and Address) Your Weaknesses: “This awareness sets you up to overcome your weak points much quicker than waiting for them to arise,” shares Dean. Brodsky recommends performing a full SWOT analysis to identify your weaknesses, too. “Your business will fare better with self-knowledge, which will help you better define the mission of your business, as well as the strategies you will choose to achieve your objectives,” he adds.
	Seek Peer or Mentor Review: “Ask for feedback on your drafts and for areas to improve,” advises Brodsky. “When your mind is filled with dreams for your business, sometimes it is an outsider who can tell you what you’re missing and will save your business from being a product of whimsy.”

Outside of these more practical tips, the language you use is also important and may make or break your business plan.
Shaun Heng, VP of Operations at Coin Market Cap , gives the following advice on the writing, “Your business plan is your sales pitch to an investor. And as with any sales pitch, you need to strike the right tone and hit a few emotional chords. This is a little tricky in a business plan, because you also need to be formal and matter-of-fact. But you can still impress by weaving in descriptive language and saying things in a more elegant way.
“A great way to do this is by expanding your vocabulary, avoiding word repetition, and using business language. Instead of saying that something ‘will bring in as many customers as possible,’ try saying ‘will garner the largest possible market segment.’ Elevate your writing with precise descriptive words and you'll impress even the busiest investor.”
Additionally, Dean recommends that you “stay consistent and concise by keeping your tone and style steady throughout, and your language clear and precise. Include only what is 100 percent necessary.”
Resources for Writing a Business Plan
While a template provides a great outline of what to include in a business plan, a live document or more robust program can provide additional functionality, visibility, and real-time updates. The U.S. Small Business Association also curates resources for writing a business plan.
Additionally, you can use business plan software to house data, attach documentation, and share information with stakeholders. Popular options include LivePlan, Enloop, BizPlanner, PlanGuru, and iPlanner.
How a Business Plan Helps to Grow Your Business
A business plan — both the exercise of creating one and the document — can grow your business by helping you to refine your product, target audience, sales plan, identify opportunities, secure funding, and build new partnerships. 
Outside of these immediate returns, writing a business plan is a useful exercise in that it forces you to research the market, which prompts you to forge your unique value proposition and identify ways to beat the competition. Doing so will also help you build (and keep you accountable to) attainable financial and product milestones. And down the line, it will serve as a welcome guide as hurdles inevitably arise.
Streamline Your Business Planning Activities with Real-Time Work Management in Smartsheet
Empower your people to go above and beyond with a flexible platform designed to match the needs of your team — and adapt as those needs change. 
The Smartsheet platform makes it easy to plan, capture, manage, and report on work from anywhere, helping your team be more effective and get more done. Report on key metrics and get real-time visibility into work as it happens with roll-up reports, dashboards, and automated workflows built to keep your team connected and informed. 
When teams have clarity into the work getting done, there’s no telling how much more they can accomplish in the same amount of time.  Try Smartsheet for free, today.
Discover why over 90% of Fortune 100 companies trust Smartsheet to get work done.
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Reviewed by Kevin Heupel, Affiliate Faculty, Metropolitan State University of Denver on 3/4/20
The text does a good job of providing a general outline about writing and developing a written business plan. All of the important steps and components are included. However, the text is light on details, examples, and rationale for each element... read more
Comprehensiveness rating: 3 see less
The text does a good job of providing a general outline about writing and developing a written business plan. All of the important steps and components are included. However, the text is light on details, examples, and rationale for each element of the business plan. Some examples from actual business plans would be helpful.
Content Accuracy rating: 4
For the most part, the content is accurate. The content covers all important aspects of drafting a business plan. I thought the industry analysis could use more information about collecting primary and secondary sources; instead, this information was referenced in the marketing plan section.
Relevance/Longevity rating: 5
Most of the content relies on cites as far back as 2006; however, when it comes to developing and writing a business plan nothing has changed. Thus, the content is current and there is no concern about it becoming obsolete in the near future.
Clarity rating: 4
The text is clear. There are no difficult terms used and the writing is simple. The text uses a lot of bullet points though, which gets tedious to read for a few pages.
Consistency rating: 5
The text does a good job of maintaining consistency in terms of framework and terminology. The text is organized where it's easy to find the information you want in a quick manner.
Modularity rating: 3
The text has a lot of bullet points and the paragraphs are dense. However, the use of subheading is excellent.
Organization/Structure/Flow rating: 5
The book is organized as if you're writing a business plan from start to finish, which is helpful as a practical guide.
Interface rating: 5
There are no navigation problems, distortion of images/charts, or any other display features that may distract or confuse the reader.
Grammatical Errors rating: 5
The text is free of grammatical errors. The sentence structure is simple with many bullet points, which helps to avoid any grammatical issues.
Cultural Relevance rating: 5
This book was written by a Canadian professor and provides references to Canadian sources. However, the information in this text can be used for U.S. schools.
This book is very short and provides a good, general overview about the process of creating and writing a business plan. It won't help a reader if he/she is confused about a certain part of the business plan. The reader will have to find another source, such as "Preparing Effective Business Plans" by Bruce Barringer, Ph.D. The book provides links to good resources and a finished business plan that the reader can reference. I would recommend the book for undergraduate courses.

Reviewed by Kenneth Lacho, Professor of Management, The University of New Orleans on 6/19/18
1. Text is relevant to Canada. Not the United States 2. Needs to cover resources available to entrepreneur, e.g., federal government agencies, trade associations, chambers of commerce, economic development agencies. 3. Discuss local economy or... read more
1. Text is relevant to Canada. Not the United States 2. Needs to cover resources available to entrepreneur, e.g., federal government agencies, trade associations, chambers of commerce, economic development agencies. 3. Discuss local economy or economic area relevant to this proposed business. 4. Business model ok as a guide. 5. Suggested mission statement to cover: product/business, target customer, geographical area covered. 6. Need detailed promotion plan, e.g., personal selling, advertising, sales promotion, networking publicity, and social media. 7. How do you find the target market? 8. Chapter 6 too much detail on debt and equity financing. 9. Discuss how to find sources of financing, e.g., angels. 10. Expand coverage of bootstring, crowdfunding. 11. Chapter 4 – good checklist. 12. Chapter 3 - overlaps. 13. Chapter 7 – 3 pages of executive summary – double or single spaced typing. Number all tables, graphs. 14. Some references out-of-date, mostly academic. Bring in trade magazines such as Entrepreneur.
Content Accuracy rating: 5
In my opinion, the content is accurate and error free.
Relevance/Longevity rating: 4
The material is relevant to writing a business plan. I wonder if the Porter, SWOT VRIO, etc. material is too high level for students who may not be seniors or have non-business degrees (e.g., liberal arts). Porter has been around for a while and does have longevity. The author has to be more alert to changes in promotion, e.g., social media and sources of financing, e.g., crowdfunding.
Clarity rating: 3
As noted in No. 9, the tone of the writing is too academic, thus making the material difficult to understand. Paragraphs are too long. Need to define: Porter, TOWS Matrix, VRIO, PESTEL. A student less from a senior or a non-business major would not be familiar with these terms.
Consistency rating: 4
The text is internally consistent. The model approach helps keep the process consistent.
Modularity rating: 4
The process of developing a business plan is divided into blocks which are parts of the business plan. Paragraphs tend to be too long in some spots.
Organization/Structure/Flow rating: 4
The topics are presented in a logical step-wise flow. The language style is too academic in parts, paragraphs too long. Leaves out the citations. Provides excellent check lists.
There are no display features which confuse the reader.
Grammatical Errors rating: 4
The text has no grammatical errors. On the other hand, I found the writing to be too academic in nature. Some paragraphs are too long. The material is more like an academic conference paper or journal submission. Academic citations references are not needed. The material is not exciting to read.
The text is culturally neutral. There are no examples which are inclusive of a variety of races, ethnicities, and backgrounds.
This book best for a graduate class.
Reviewed by Louis Bruneau, Part Time Faculty, Portland Community College on 6/19/18
The text provides appropriate discussion and illustration of all major concepts and useful references to source and resource materials. read more
Comprehensiveness rating: 5 see less
The text provides appropriate discussion and illustration of all major concepts and useful references to source and resource materials.
Contents of the book were accurate, although it could have benefited from editing/proofreading; there was no evidence of bias. As to editing/proofreading, a couple of examples: A. “Figure 1 – Business Plan… “ is shown at the top of the page following the diagram vs. the bottom of the page the diagram is on. (There are other problems with what is placed on each page.) B. First paragraph under heading “Essential Initial Research” there is reference to pages 21 to 30 though page numbering is missing from the book. (Page numbers are used in the Table of Contents.)
The book is current in that business planning has been stable for sometime. The references and resources will age in time, but are limited and look easy to update.
Clarity rating: 5
The book is written in a straightforward way, technical terms that needed explanations got them, jargon was avoided and generally it was an easy read.
The text is internally consistent in terms of terminology and framework.
Modularity rating: 5
The book lends itself to a multi-week course. A chapter could be presented and students could work on that stage of Plan development. It could also be pre-meeting reading for a workshop presentation. Reorganizing the book would be inappropriate.
The topics in the text are presented in a logical, clear fashion.
Generally, the book is free of interface problems. The financial tables in the Sample Plan were turned 90° to maintain legibility. One potential problem was with Figure 6 – Business Model Canvas. The print within the cells was too small to read; the author mitigated the problem by presenting the information, following Figure 6, in the type font of the text.
I found no grammatical errors.
The text is not culturally insensitive or offensive in any way.
I require a business plan in a course I teach; for most of the students the assignment is a course project that they do not intend to pursue in real life. I shared the book with five students that intended to develop an actual start-up business; three of them found it helpful while the other two decided not to do that much work on their plans. If I were planning a start-up, I would use/follow the book.
Reviewed by Todd Johnson, Faculty of Business, North Hennepin Community College on 5/21/18
The text is a thorough overview of all elements of a business plan. read more
Comprehensiveness rating: 4 see less
The text is a thorough overview of all elements of a business plan.
The content is accurate and seems to lack bias.
Content seems relevant and useful . It does not help an entrepreneur generate ideas, and is very light on crowdfunding and other novel funding source content. It is more traditional. This can be easily updated in future versions, however. "Social Media" appears once in the book, as does "Crowd Funding".
The book is comprehensive, but perhaps not written in the most lucid, accessible prose. I am not sure any college student could pick this up and just read and learn. It would be best used as a "teach along guide" for students to process with an instructor.
The text seems consistent. The author does a nice job of consistently staying on task and using bullets and brevity.
Here I am not so certain. The table of contents is not a good guide for this book. It does make the book look nicely laid out, but there is a lot of complexity within these sections. I read it uncertain that it was well organized. Yes there are many good bits of information, however it is not as if I could spend time on one swathe of text at a time. I would need to go back and forth throughout the text.
Organization/Structure/Flow rating: 2
Similar to the above. I did not like the flow and organization of this. An editor would help things be in a more logical order.
Interface rating: 2
The interface is just OK. It is not an attractice interface, as it presents text in a very dense manner. The images and charts are hard to follow.
I did not find any grammatical errors.
Cultural Relevance rating: 4
I a not certain of the origins of Saskatchewan, but I do feel this is a different read. It is more formal and dense than it has to be. This would be a difficult read for my students. I do not feel it is insensitive in any way, or offensive in any way.
I would not adopt this book if given the chance. It is too dense, and not organized very well, even though the information is very good. The density and lack of modularity are barriers to understanding what is obviously very good information.
Reviewed by Mariana Mitova, Lecturer, Bowling Green State University on 2/1/18
Though this textbook has a prescriptive nature, it is quite comprehensive. The author strikes a good balance between presenting concepts in a concise way and providing enough information to explain them. Many every-day examples and live links to... read more
Though this textbook has a prescriptive nature, it is quite comprehensive. The author strikes a good balance between presenting concepts in a concise way and providing enough information to explain them. Many every-day examples and live links to other resources add to the completeness of the textbook.
Content seems accurate.
Since the content is somewhat conceptual, the text will not become obsolete quickly. In addition, the author seems to be updating and editing content often hence the relevance to current developments is on target.
The text is very clear, written in clear and straight-to-the point language.
The organization of content is consistent throughout the entire text.
The textbook is organized by chapters, beginning with overview of the model used and followed by chapters for each concept within the model. Nicely done.
The flow is clear, logical and easy to follow.
Overall, images, links, and text are well organized. Some headlines were misaligned but still easy to follow.
No concerns for grammar.
No concerns for cultural irrelevance.
Reviewed by Darlene Weibye, Cosmetology Instructor, Minnesota State Community and Technical College on 2/1/18
The text is comprehensive and covers the information needed to develop a business plan. The book provides all the means necessary in business planning. read more
The text is comprehensive and covers the information needed to develop a business plan. The book provides all the means necessary in business planning.
The text was accurate, and error-free. I did not find the book to be biased.
The content is up-to-date. I am reviewing the book in 2017, the same year the book was published.
The content was very clear. A business plan sample included operation timelines, start up costs, and all relevant material in starting a business.
The book is very consistent and is well organized.
The book has a table of contents and is broken down into specific chapters. The chapters are not divided into sub topics. I do not feel it is necessary for sub topics because the chapters are brief and to the point.
There is a great flow from chapter to chapter. One topic clearly leads into the next without repeating.
The table of contents has direct links to each chapter. The appearance of the chapters are easy to read and the charts are very beneficial.
Does not appear to have any grammatical errors.
The text is not culturally insensitive or offensive.
I am incorporating some of the text into the salon business course. Very well written book.
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You’re our first priority. Every time.
We believe everyone should be able to make financial decisions with confidence. And while our site doesn’t feature every company or financial product available on the market, we’re proud that the guidance we offer, the information we provide and the tools we create are objective, independent, straightforward — and free.
So how do we make money? Our partners compensate us. This may influence which products we review and write about (and where those products appear on the site), but it in no way affects our recommendations or advice, which are grounded in thousands of hours of research. Our partners cannot pay us to guarantee favorable reviews of their products or services. Here is a list of our partners .
How to Write a Business Plan, Step by Step

Many or all of the products featured here are from our partners who compensate us. This influences which products we write about and where and how the product appears on a page. However, this does not influence our evaluations. Our opinions are our own. Here is a list of our partners and here's how we make money .
1. Write an executive summary
2. describe your company, 3. state your business goals, 4. describe your products and services, 5. do your market research, 6. outline your marketing and sales plan, 7. perform a business financial analysis, 8. make financial projections, 9. add additional information to an appendix, business plan tips and resources.
A business plan is a document that outlines your business’s financial goals and explains how you’ll achieve them. A strong, detailed plan will provide a road map for the business’s next three to five years, and you can share it with potential investors, lenders or other important partners.

Here’s a step-by-step guide to writing your business plan.
» Need help writing? Learn about the best business plan software .
This is the first page of your business plan. Think of it as your elevator pitch. It should include a mission statement, a brief description of the products or services offered, and a broad summary of your financial growth plans.
Though the executive summary is the first thing your investors will read, it can be easier to write it last. That way, you can highlight information you’ve identified while writing other sections that go into more detail.
» MORE: How to write an executive summary in 6 steps
Next up is your company description, which should contain information like:
Your business’s registered name.
Address of your business location .
Names of key people in the business. Make sure to highlight unique skills or technical expertise among members of your team.
Your company description should also define your business structure — such as a sole proprietorship, partnership or corporation — and include the percent ownership that each owner has and the extent of each owner’s involvement in the company.
Lastly, it should cover the history of your company and the nature of your business now. This prepares the reader to learn about your goals in the next section.
» MORE: How to write a company overview for a business plan

The third part of a business plan is an objective statement. This section spells out exactly what you’d like to accomplish, both in the near term and over the long term.
If you’re looking for a business loan or outside investment, you can use this section to explain why you have a clear need for the funds, how the financing will help your business grow, and how you plan to achieve your growth targets. The key is to provide a clear explanation of the opportunity presented and how the loan or investment will grow your company.
For example, if your business is launching a second product line, you might explain how the loan will help your company launch the new product and how much you think sales will increase over the next three years as a result.
In this section, go into detail about the products or services you offer or plan to offer.
You should include the following:
An explanation of how your product or service works.
The pricing model for your product or service.
The typical customers you serve.
Your supply chain and order fulfillment strategy.
Your sales strategy.
Your distribution strategy.
You can also discuss current or pending trademarks and patents associated with your product or service.
Lenders and investors will want to know what sets your product apart from your competition. In your market analysis section , explain who your competitors are. Discuss what they do well, and point out what you can do better. If you’re serving a different or underserved market, explain that.
Here, you can address how you plan to persuade customers to buy your products or services, or how you will develop customer loyalty that will lead to repeat business.
» MORE: R e a d our complete guide to small business marketing
If you’re a startup, you may not have much information on your business financials yet. However, if you’re an existing business, you’ll want to include income or profit-and-loss statements, a balance sheet that lists your assets and debts, and a cash flow statement that shows how cash comes into and goes out of the company.
You may also include metrics such as:
Net profit margin: the percentage of revenue you keep as net income.
Current ratio: the measurement of your liquidity and ability to repay debts.
Accounts receivable turnover ratio: a measurement of how frequently you collect on receivables per year.
This is a great place to include charts and graphs that make it easy for those reading your plan to understand the financial health of your business.
» NerdWallet’s picks for setting up your business finances:
The best business checking accounts .
The best business credit cards .
The best accounting software .
This is a critical part of your business plan if you’re seeking financing or investors. It outlines how your business will generate enough profit to repay the loan or how you will earn a decent return for investors.
Here, you’ll provide your business’s monthly or quarterly sales, expenses and profit estimates over at least a three-year period — with the future numbers assuming you’ve obtained a new loan.
Accuracy is key, so carefully analyze your past financial statements before giving projections. Your goals may be aggressive, but they should also be realistic.
List any supporting information or additional materials that you couldn’t fit in elsewhere, such as resumes of key employees, licenses, equipment leases, permits, patents, receipts, bank statements, contracts and personal and business credit history. If the appendix is long, you may want to consider adding a table of contents at the beginning of this section.
How much do you need?
with Fundera by NerdWallet
We’ll start with a brief questionnaire to better understand the unique needs of your business.
Once we uncover your personalized matches, our team will consult you on the process moving forward.
Here are some tips to help your business plan stand out:
Avoid over-optimism: If you’re applying for a business loan at a local bank, the loan officer likely knows your market pretty well. Providing unreasonable sales estimates can hurt your chances of loan approval.
Proofread: Spelling, punctuation and grammatical errors can jump off the page and turn off lenders and prospective investors, taking their mind off your business and putting it on the mistakes you made. If writing and editing aren't your strong suit, you may want to hire a professional business plan writer, copy editor or proofreader.
Use free resources: SCORE is a nonprofit association that offers a large network of volunteer business mentors and experts who can help you write or edit your business plan. You can search for a mentor or find a local SCORE chapter for more guidance.
The U.S. Small Business Administration’s Small Business Development Centers , which provide free business consulting and help with business plan development, can also be a resource.
On a similar note...
Find small-business financing
Compare multiple lenders that fit your business
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Learning Objectives
After completing this chapter, you will be able to
	Describe the purposes for business planning
	Describe common business planning principles
	Explain common business plan development guidelines and tools
	List and explain the elements of the business plan development process
	Explain the purposes of each element of the business plan development process
	Explain how applying the business plan development process can aid in developing a business plan that will meet entrepreneurs’ goals

This chapter describes the purposes, principles, and the general concepts and tools for business planning, and the process for developing a business plan.
Purposes for Developing Business Plans
Business plans are developed for both internal and external purposes. Internally, entrepreneurs develop business plans to help put the pieces of their business together. Externally, the most common purpose is to raise capital.
Internal Purposes
As the road map for a business’s development, the business plan
	Defines the vision for the company
	Establishes the company’s strategy
	Describes how the strategy will be implemented
	Provides a framework for analysis of key issues
	Provides a plan for the development of the business
	Helps the entrepreneur develop and measure critical success factors
	Helps the entrepreneur to be realistic and test theories

External Purposes
The business plan provides the most complete source of information for valuation of the business. Thus, it is often the main method of describing a company to external audiences such as potential sources for financing and key personnel being recruited. It should assist outside parties to understand the current status of the company, its opportunities, and its needs for resources such as capital and personnel.
Business Plan Development Principles
Hindle and Mainprize (2006) suggested that business plan writers must strive to effectively communicate their expectations about the nature of an uncertain future and to project credibility. The liabilities of newness make communicating the expected future of new ventures much more difficult than for existing businesses. Consequently, business plan writers should adhere to five specific communication principles .
First, business plans must be written to meet the expectations of targeted readers in terms of what they need to know to support the proposed business. They should also lay out the milestones that investors or other targeted readers need to know. Finally, writers must clearly outline the opportunity , the context within the proposed venture will operate (internal and external environment), and the business model (Hindle & Mainprize, 2006).
There are also five business plan credibility principles that writers should consider. Business plan writers should build and establish their credibility by highlighting important and relevant information about the venture team . Writers need to elaborate on the plans they outline in their document so that targeted readers have the information they need to assess the plan’s credibility. To build and establish credibility, they must integrate scenarios to show that the entrepreneur has made realistic assumptions and has effectively anticipated what the future holds for their proposed venture. Writers need to provide comprehensive and realistic financial links between all relevant components of the plan. Finally, they must outline the deal , or the value that targeted readers should expect to derive from their involvement with the venture (Hindle & Mainprize, 2006).

General Guidelines for Developing Business Plans
Many businesses must have a business plan to achieve their goals. Using a standard format helps the reader understand that the you have thought everything through, and that the returns justify the risk. The following are some basic guidelines for business plan development.
As You Write Your Business Plan
1. If appropriate, include nice, catchy, professional graphics on your title page to make it appealing to targeted readers, but don’t go overboard.
2. Bind your document so readers can go through it easily without it falling apart. You might use a three-ring binder, coil binding, or a similar method. Make sure the binding method you use does not obscure the information next to where it is bound.
3. Make certain all of your pages are ordered and numbered correctly.
4. The usual business plan convention is to number all major sections and subsections within your plan using the format as follows:
1. First main heading
1.1 First subheading under the first main heading
1.1.1. First sub-subheading under the first subheading
2. Second main heading
2.1 First subheading under the second main heading
Use the styles and references features in Word to automatically number and format your section titles and to generate your table of contents. Be sure that the last thing you do before printing your document is update your automatic numbering and automatically generated tables. If you fail to do this, your numbering may be incorrect.
5. Prior to submitting your plan, be 100% certain each of the following requirements are met:
	Everything must be completely integrated. The written part must say exactly the same thing as the financial part.
	All financial statements must be completely linked and valid. Make sure all of your balance sheets balance.
	Everything must be correct. There should be NO spelling, grammar, sentence structure, referencing, or calculation errors.
	Your document must be well organized and formatted. The layout you choose should make the document easy to read and comprehend. All of your diagrams, charts, statements, and other additions should be easy to find and be located in the parts of the plan best suited to them.
	In some cases it can strengthen your business plan to show some information in both text and table or figure formats. You should avoid unnecessary repetition , however, as it is usually unnecessary—and even damaging—to state the same thing more than once.
	You should include all the information necessary for readers to understand everything in your document.
	The terms you use in your plan should be clear and consistent. For example, the following statement in a business plan would leave a reader completely confused: “There is a shortage of 100,000 units with competitors currently producing 25,000. We can help fill this huge gap in demand with our capacity to produce 5,000 units.”

How to Write a Food and Beverage Business Plan + Sample Business Plan PDF

Elon Glucklich
7 min. read
Updated February 17, 2024
Free Download: Sample Food and Beverage Business Plan Templates
The food and beverage sector is booming. Restaurant openings rose 10% in 2023 compared to 2022 — even higher than in pre-pandemic years.
From fine dining to food trucks, farmers to brewers, and wholesalers to coffee makers, there are opportunities across the food and beverage industry. 
But starting a business without covering the basics — your operations plan, marketing tactics, financial strategy, and more — carries huge risks. 
That’s why we recommend you write a business plan.
	Why write a food and beverage business plan?

Writing a business plan is an easy first step that you can start for free. Plus, businesses that take time to plan are significantly more successful than those that don’t.
Many food and beverage establishments fail because of one of the following:
	Poor inventory management
	Underestimated expenses
	High employee turnover
	Misjudged the size of their market

Writing a business plan can help you:
	Develop processes for managing inventory and logistics
	Understand your cash flows and create a realistic expense budget
	Budget for competitive employee pay that increases worker retention
	Analyze your competition and determine how big your market is  

If you’re looking for funding from investors for your business, you’ll definitely need a business plan.
What’s your biggest business challenge right now?
	How to write a food and beverage business plan

Many business plans follow a standard format and you can use it as a starting point when writing your own plan. Here’s what that includes:
Executive summary
	Company summary and funding needs
	Products and services
	Marketing plan
	Management team

Financial plan
For food and beverage companies, you must give extra attention to your market analysis, operations plan, and financial forecasts.
If you’re ready to start, download a free business plan template and fill it out as you read this article.

Every business plan should include an executive summary . It’s a brief outline summarizing the plan, no more than one or two pages.
We recommend that you write the executive summary last after fleshing out the details of your plan. 
Just summarize the vision for your business, describe your offerings and target market , and touch on your management team and financials. Don’t go into tons of detail — just provide a high-level sense of what you want your business to accomplish.
Opportunity: problem and solution
This section of your food and beverage business plan describes the opportunity you hope to capture.
Maybe you’re a farmer looking to diversify your revenue streams by distributing to grocery stores. Or a bar owner with high-end liquor that competitors in the market aren’t serving. 
Whatever your business is, describe the gap in the market and how you aim to fill it.
If you’re operating a more common type of business, like a restaurant , you can probably keep this section short. But it’s useful to document what makes your business unique and it will help focus your sales and marketing efforts later on.
Market analysis
In a field as crowded with competitors as the food and beverage space, a detailed market analysis is essential. 
Your focus should be on identifying the specific customer segments you aim to serve. 
Maybe you’re a butcher with connections to fresh livestock. Will you be more successful selling directly to consumers, or should you focus on selling to grocery stores and markets in your area?
Or, you’re opening  a diner. Should your menu focus on healthy meals or easy-to-make child-friendly options?
These are the types of questions that market research helps you answer. This section should detail the defining characteristics of your target market, including the demographics and preferences of your ideal customer and the size of the market you’re targeting. Market research questions specific to a food and beverage business could include:
	Business location and characteristics
	Area income
	Local food and beverage preferences
	Existing food and beverage options 

Elaborate on how your food and beverage offerings align with that target market ’s needs. Remember, you can’t please everyone, so focus on a specific group of people or type of person and build out from there.
Marketing and sales
For food and beverage businesses promotions are how you stand out and seize a share of your market.
The marketing and advertising chapter of your business plan is where you’ll detail your strategies for capturing the attention — and loyalty — of the customers you identified as your target market in the previous section.
With so many options for consumers in the food and beverage space, you’ll likely have to rely on multiple marketing channels , including::
	Advertising on websites, television, and in relevant publications.
	Content marketing — developing an engaging website and writing blog content that’s search engine optimized to drive traffic to your site.
	Engaging with your customers on social media.
	Offering discounts and customer loyalty programs.
	Appearing at food and beverage industry trade shows and community events.

It doesn’t matter how delicious your recipes are, how fresh your crops are, or how innovative your cocktails are — if you don’t operate efficiently, your business probably won’t last long.
The operations strategy may be the most detailed section of your business plan, especially if you’re writing it for a bank loan or investment. This section describes how you will run your business day to day.
When writing the operations section, describe the following:
Physical space
Whether it’s a restaurant, a farm, or a food transportation business, describe the space you’re operating in, and all of the physical assets and equipment you’ll need to be successful. 
If it’s a sit-down restaurant, consider including a floorplan mockup in your appendix.
Supply chain 
List the suppliers and partners that get your product to customers. Think about the businesses you purchase ingredients from, the warehouses that goods are stored in, and the trucking companies that deliver your products to grocery stores. 
These are your supply chain partners. It’s crucial that you maintain good relationships with them.
Production processes
How long it takes to make your product, and what materials and equipment are required. Documenting how you produce your goods or services demonstrates that you understand the costs of making them. 
You may also uncover ways to produce them more quickly, or at a lesser cost.
Detail how you’ll handle matters of efficiency like order fulfillment, storage, shipping, and returns, as well as customer satisfaction. If you provide delivery services, document how you will handle the process of getting your product to customers’ homes or businesses.
List your staffing needs, training, and experience requirements for key staff. Also, document the management structure of your business. 
This helps ensure that important tasks you don’t have time to monitor are being done and that workers are being supervised.
Describe investments in payment processing systems, inventory management software, and other tools that support sales or operations in your business. Cataloging your technology systems will help you determine where it might make sense to invest in upgrades for efficiency.
Take some time to write a financial plan . Create detailed financial projections, including sales , expenses , and profitability .
If that sounds intimidating, take a deep breath, and remember that financial forecasts are really just best guesses. If you’re running an existing business, you can start with your previous year’s numbers. If you’re starting, make an educated guess about where you hope to be financially a year from now.
Investors will want to see a: 
	Sales forecast
	Income statement (also called a profit and loss statement )
	Cash flow statement
	Balance sheet 

If you use a tool like LivePlan , you’ll be able to build out your financial forecasts relatively quickly, even if you don’t have experience with business numbers.
Even if you aren’t seeking investment, the financial plan is crucial for understanding the viability of your business. It allows you to adjust your business model based on projected performance, and make informed decisions about where to spend your money.
	Food and beverage business plan templates and examples

If you want to see how other food and beverage businesses have created their plans, check out our free library of food and beverage business plans . 
You can download all of them in Word format and jump-start your own business plan.

See why 1.2 million entrepreneurs have written their business plans with LivePlan

Elon is a marketing specialist at Palo Alto Software, working with consultants, accountants, business instructors and others who use LivePlan at scale. He has a bachelor's degree in journalism and an MBA from the University of Oregon.
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Orthopedic Clinic Business Plan PDF Example
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	Business Plan


Creating a comprehensive business plan is crucial for launching and running a successful orthopedic clinic. This plan serves as your roadmap, detailing your vision, operational strategies, and financial plan. It helps establish your orthopedic clinic’s identity, navigate the competitive market, and secure funding for growth.
This article not only breaks down the critical components of an orthopedic clinic business plan, but also provides an example of a business plan to help you craft your own.
Whether you’re an experienced entrepreneur or new to the healthcare industry, this guide, complete with a business plan example, lays the groundwork for turning your orthopedic clinic concept into reality. Let’s dive in!
Our orthopedic clinic business plan is structured to encompass all vital elements necessary for a robust strategy. It outlines the clinic’s operations, marketing approach, market environment, competitors, management team, and financial predictions.
	Executive Summary: Offers an overview of the Orthopedic Clinic’s business concept, emphasizing its specialized orthopedic services, market analysis highlighting the growing demand for orthopedic care, a highly qualified management team, and a financial strategy aimed at achieving sustainability and growth.
	Clinic & Location: Describes the clinic’s design, state-of-the-art orthopedic equipment, patient amenities, and the strategic significance of its location for accessibility and patient convenience.
	Operations: Lists the comprehensive range of orthopedic treatments available, including fracture care, joint replacement, sports medicine, and specialized surgeries, alongside a transparent pricing model.
	Key Stats: Discusses the industry’s size and growth trends, emphasizing the increasing interest in minimally invasive surgical techniques and treatments for an aging population.
	Key Trends: Highlights significant trends such as the integration of advanced technology in treatment and diagnostics, the focus on value-based care, and the shift towards ambulatory surgery centers.
	Key Competitors: Analyzes the main competitors in the area, noting how the Orthopedic Clinic distinguishes itself through its wide range of specialized services, advanced treatment techniques, and patient-centered care approach.
	SWOT: A detailed Strengths, Weaknesses, Opportunities, and Threats analysis, tailored to the Orthopedic Clinic’s context, to inform strategic planning.
	Marketing Plan: A comprehensive strategy for promoting the clinic’s services, including digital marketing, partnerships with healthcare providers, patient education seminars, and community health initiatives.
	Timeline: Sets key milestones and objectives from the clinic’s conceptualization through to its first year of operation, including critical phases like staff recruitment, service launch, and the initiation of marketing activities.
	Management: Provides information on the Orthopedic Clinic’s management team, detailing the roles, qualifications, and expertise of key personnel, emphasizing their capability to lead the clinic towards achieving its strategic goals.
	Financial Plan: Projects the Orthopedic Clinic’s 5-year financial performance, including detailed forecasts of revenue from various treatments, projected expenses, and profitability analysis to demonstrate the clinic’s potential for financial success and operational sustainability.


Orthopedic Clinic Business Plan
Download an expert-built 30+ slides Powerpoint business plan template
Executive Summary
The Executive Summary introduces your orthopedic clinic’s business plan, offering a concise overview of your clinic and its services. It should detail your market positioning, the range of orthopedic and rehabilitative services you offer, its location, size, and an outline of day-to-day operations. 
This section should also explore how your orthopedic clinic will integrate into the local healthcare market, including the number of direct competitors within the area, identifying who they are, along with your clinic’s unique selling points that differentiate it from these competitors. 
Furthermore, you should include information about the management and co-founding team, detailing their roles and contributions to the clinic’s success. Additionally, a summary of your financial projections, including revenue and profits over the next five years, should be presented here to provide a clear picture of your clinic’s financial plan.
Make sure to cover here _ Business Overview _ Market Overview _ Management Team _ Financial Plan

Dive deeper into Executive Summary
Business Overview
For an Orthopedic Clinic, the Business Overview section can be effectively divided into 2 main slides:
Clinic & Location
Briefly describe the clinic’s physical environment, focusing on its design, accessibility, and the professional atmosphere that reassures and welcomes patients. Mention the clinic’s location, highlighting its convenience for patients, such as proximity to major transportation routes or integration within a medical complex. Explain why this location is beneficial for reaching your target patient demographic and ensuring ease of access for those with mobility issues.
Operations & Services
Detail the range of orthopedic services and treatments offered, from routine consultations and diagnostics to advanced surgical procedures and post-surgery rehabilitation. Outline your service delivery model, ensuring it reflects the high standard of care and aligns with the expectations of your target market. Highlight any specialized programs, such as sports injury rehabilitation, pediatric orthopedics, or geriatric orthopedic care, that provide added value to your patients, fostering patient engagement and loyalty.
Make sure to cover here _ Facility&location _ Treatment&Pricing

Market Overview
In the Market Overview of your orthopedic clinic business plan, begin by examining the size of the orthopedic care industry and its growth potential. This analysis is essential for understanding the market’s scope and pinpointing areas for expansion.
Proceed to discuss recent market trends, such as the growing patient preference for minimally invasive surgical techniques, the increasing use of telemedicine for consultations and follow-ups, and the emphasis on integrated care models that combine surgical treatment with physiotherapy and rehabilitation. For instance, highlight the demand for services that cater to specific orthopedic needs, such as sports injuries, joint replacements, or pediatric orthopedics, alongside the rising interest in clinics that offer comprehensive care from diagnosis to full recovery.
Then, consider the competitive landscape, which includes a spectrum of providers from specialized orthopedic hospitals to multi-specialty clinics, as well as independent practitioners. For example, emphasize what makes your clinic stand out, whether it’s through advanced surgical technologies, a team of renowned specialists, or a patient-centered approach to care. This section will help articulate the demand for orthopedic services, the competitive environment, and how your clinic is positioned to succeed within this evolving market.
Make sure to cover here _ Industry size & growth _ Key competitors _ Key market trends

Dive deeper into Key competitors
First, conduct a SWOT analysis for the orthopedic clinic, highlighting Strengths (such as experienced orthopedic specialists and state-of-the-art medical equipment), Weaknesses (including reliance on healthcare insurance reimbursements or intense competition in the area), Opportunities (for example, an aging population with increasing orthopedic needs or advancements in orthopedic treatments), and Threats (such as changes in healthcare regulations that may affect operational costs or reimbursement rates).
Next, develop a marketing strategy that outlines how to attract and retain patients through targeted advertising in healthcare publications, promotional health check-up camps, an informative and engaging online presence, and community involvement through health awareness programs.
Finally, create a detailed timeline that outlines critical milestones for the orthopedic clinic’s inauguration, marketing initiatives, patient base growth, and expansion goals, ensuring the business advances with clear direction and purpose.
Make sure to cover here _ SWOT _ Marketing Plan _ Timeline

Dive deeper into SWOT
Dive deeper into Marketing Plan
The Management section focuses on the orthopedic clinic’s management and its direct roles in daily operations and strategic direction. This part is crucial for understanding who is responsible for making key decisions and driving the orthopedic clinic toward its financial and operational goals.
For your orthopedic clinic business plan, list the core team members, their specific responsibilities, and how their expertise supports the orthopedic clinic’s mission.

Financial Plan
The Financial Plan section is a comprehensive analysis of the orthopedic clinic’s financial strategy, including projections for revenue, expenses, and profitability. It lays out the orthopedic clinic’s approach to securing funding, managing cash flow, and achieving breakeven.
This section typically includes detailed forecasts for the first 5 years of operation, highlighting expected revenue, operating costs and capital expenditures.
For your orthopedic clinic business plan, provide a snapshot of your financial statement (profit and loss, balance sheet, cash flow statement), as well as your key assumptions (e.g. pricing strategies for memberships and services, etc.).
Make sure to cover here _ Profit and Loss _ Cash Flow Statement _ Balance Sheet _ Use of Funds

Privacy Overview

Create a form in Word that users can complete or print
In Word, you can create a form that others can fill out and save or print.  To do this, you will start with baseline content in a document, potentially via a form template.  Then you can add content controls for elements such as check boxes, text boxes, date pickers, and drop-down lists. Optionally, these content controls can be linked to database information.  Following are the recommended action steps in sequence.  
Show the Developer tab
In Word, be sure you have the Developer tab displayed in the ribbon.  (See how here:  Show the developer tab .)
Open a template or a blank document on which to base the form
You can start with a template or just start from scratch with a blank document.
Start with a form template
Go to File > New .
In the  Search for online templates  field, type  Forms or the kind of form you want. Then press Enter .
In the displayed results, right-click any item, then select  Create. 
Start with a blank document 
Select Blank document .
Add content to the form
Go to the  Developer  tab Controls section where you can choose controls to add to your document or form. Hover over any icon therein to see what control type it represents. The various control types are described below. You can set properties on a control once it has been inserted.
To delete a content control, right-click it, then select Remove content control  in the pop-up menu. 
Note:  You can print a form that was created via content controls. However, the boxes around the content controls will not print.
Insert a text control
The rich text content control enables users to format text (e.g., bold, italic) and type multiple paragraphs. To limit these capabilities, use the plain text content control . 
Click or tap where you want to insert the control.

To learn about setting specific properties on these controls, see Set or change properties for content controls .
Insert a picture control
A picture control is most often used for templates, but you can also add a picture control to a form.

Insert a building block control
Use a building block control  when you want users to choose a specific block of text. These are helpful when you need to add different boilerplate text depending on the document's specific purpose. You can create rich text content controls for each version of the boilerplate text, and then use a building block control as the container for the rich text content controls.

Select Developer and content controls for the building block.

Insert a combo box or a drop-down list
In a combo box, users can select from a list of choices that you provide or they can type in their own information. In a drop-down list, users can only select from the list of choices.

Select the content control, and then select Properties .
To create a list of choices, select Add under Drop-Down List Properties .
Type a choice in Display Name , such as Yes , No , or Maybe .
Repeat this step until all of the choices are in the drop-down list.
Fill in any other properties that you want.
Note:  If you select the Contents cannot be edited check box, users won’t be able to click a choice.
Insert a date picker
Click or tap where you want to insert the date picker control.

Insert a check box
Click or tap where you want to insert the check box control.

Use the legacy form controls
Legacy form controls are for compatibility with older versions of Word and consist of legacy form and Active X controls.
Click or tap where you want to insert a legacy control.

Select the Legacy Form control or Active X Control that you want to include.
Set or change properties for content controls
Each content control has properties that you can set or change. For example, the Date Picker control offers options for the format you want to use to display the date.
Select the content control that you want to change.
Go to Developer > Properties .

Change the properties that you want.
Add protection to a form
If you want to limit how much others can edit or format a form, use the Restrict Editing command:
Open the form that you want to lock or protect.
Select Developer > Restrict Editing .

After selecting restrictions, select Yes, Start Enforcing Protection .

Advanced Tip:
If you want to protect only parts of the document, separate the document into sections and only protect the sections you want.
To do this, choose Select Sections in the Restrict Editing panel. For more info on sections, see Insert a section break .

If the developer tab isn't displayed in the ribbon, see Show the Developer tab .
Open a template or use a blank document
To create a form in Word that others can fill out, start with a template or document and add content controls. Content controls include things like check boxes, text boxes, and drop-down lists. If you’re familiar with databases, these content controls can even be linked to data.
Go to File > New from Template .

In Search, type form .
Double-click the template you want to use.
Select File > Save As , and pick a location to save the form.
In Save As , type a file name and then select Save .
Start with a blank document
Go to File > New Document .

Go to File > Save As .
Go to Developer , and then choose the controls that you want to add to the document or form. To remove a content control, select the control and press Delete. You can set Options on controls once inserted. From Options, you can add entry and exit macros to run when users interact with the controls, as well as list items for combo boxes, .
Adding content controls to your form
In the document, click or tap where you want to add a content control.
On Developer , select Text Box , Check Box , or Combo Box .

To set specific properties for the control, select Options , and set .
Repeat steps 1 through 3 for each control that you want to add.
Set options
Options let you set common settings, as well as control specific settings. Select a control and then select Options to set up or make changes.
Set common properties.
Select Macro to Run on lets you choose a recorded or custom macro to run on Entry or Exit from the field.
Bookmark Set a unique name or bookmark for each control.
Calculate on exit This forces Word to run or refresh any calculations, such as total price when the user exits the field.
Add Help Text Give hints or instructions for each field.
OK Saves settings and exits the panel.
Cancel Forgets changes and exits the panel.
Set specific properties for a Text box
Type Select form Regular text, Number, Date, Current Date, Current Time, or Calculation.
Default text sets optional instructional text that's displayed in the text box before the user types in the field. Set Text box enabled to allow the user to enter text into the field.
Maximum length sets the length of text that a user can enter. The default is Unlimited .
Text format can set whether text automatically formats to Uppercase , Lowercase , First capital, or Title case .
Text box enabled Lets the user enter text into a field. If there is default text, user text replaces it.
Set specific properties for a Check box .
Default Value Choose between Not checked or checked as default.
Checkbox size Set a size Exactly or Auto to change size as needed.
Check box enabled Lets the user check or clear the text box.
Set specific properties for a Combo box
Drop-down item Type in strings for the list box items. Press + or Enter to add an item to the list.
Items in drop-down list Shows your current list. Select an item and use the up or down arrows to change the order, Press - to remove a selected item.
Drop-down enabled Lets the user open the combo box and make selections.
Protect the form
Go to Developer > Protect Form .

Note:  To unprotect the form and continue editing, select Protect Form again.
Save and close the form.
Test the form (optional)
If you want, you can test the form before you distribute it.
Protect the form.
Reopen the form, fill it out as the user would, and then save a copy.
Creating fillable forms isn’t available in Word for the web.
You can create the form with the desktop version of Word with the instructions in Create a fillable form .
When you save the document and reopen it in Word for the web, you’ll see the changes you made.

Need more help?
Want more options.
Explore subscription benefits, browse training courses, learn how to secure your device, and more.

Microsoft 365 subscription benefits

Microsoft 365 training

Microsoft security

Accessibility center
Communities help you ask and answer questions, give feedback, and hear from experts with rich knowledge.

Ask the Microsoft Community

Microsoft Tech Community

Windows Insiders
Microsoft 365 Insiders
Was this information helpful?
Thank you for your feedback.
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	PDF HOW TO WRITE A BUSINESS PLAN
1. Internal: Providing management and staff with a clear map, complete with signposts and milestones against which progress can be monitored and evaluated. 2. External: Presenting the investment case to an outsider. This key function provides the focus for this note. Essentially, business plans are sales documents.




	PDF Getting started on your business plan: A workbook
1. Business overview Use this section to tell your audience what your business is about. What product(s) or service(s) does it offer? What problem are you attempting to solve and for whom? How will you solve it? What business model (such as brick-and-mortar retail or direct-to-consumer sales through an online store) will you use to make sales?




	Free PDF Business Plan Templates
Managing Work Strategic planning Free PDF Business Plan Templates and Samples Get free Smartsheet templates By Joe Weller | September 9, 2020 We've gathered the most useful collection of business plan PDF templates and samples, including options for organizations of any size and type.




	Write your business plan
Include your mission statement, your product or service, and basic information about your company's leadership team, employees, and location. You should also include financial information and high-level growth plans if you plan to ask for financing.




	How to Write a Simple Business Plan
Get free Smartsheet templates By Joe Weller | October 11, 2021 A business plan is the cornerstone of any successful company, regardless of size or industry. This step-by-step guide provides information on writing a business plan for organizations at any stage, complete with free templates and expert advice.




	PDF The Elements of a Business Plan: First Steps for New Entrepreneurs
First, a business plan helps provide direction by making you discuss where you want to take the venture and define what you want out of it. Second, a business plan provides structure to your thinking and helps you make sure you've covered all of the important areas. Third, a business plan prompts you to think about the future.




	How to Write a Business Plan: Guide + Examples
How to Write a Business Plan: Step-by-Step Guide + Examples Noah Parsons 24 min. read Updated February 2, 2024 Download Now: Free Business Plan Template Writing a business plan doesn't have to be complicated.




	Business Plan Template in PDF
Use our downloadable free business plan template PDF to outline your company's goals and milestones, including how to structure, run, and grow your new business. Bring on investors or new business partners Use your powerful business plan to get funding or bring on new business partners.




	How to Write a Great Business Plan
Classic How to Write a Great Business Plan By: William A. Sahlman Every seasoned investor knows that detailed financial projections for a new company are an act of imagination. Nevertheless, most business plans pour far too much ink on the numbers--and far too… Length: 11 page (s) Publication Date: Jul 1, 1997 Discipline: Entrepreneurship




	Writing a Business Plan: The Basics
By: HBS Press, Harvard Business School Press. Every entrepreneur is encouraged to write a business plan; those who don't quickly learn that future operations can be derailed without a cohesive printed mission and that obtaining outside funding…. Length: 43 page (s) Publication Date: Oct 30, 2004. Discipline: Entrepreneurship.




	PDF Business Planning Guide: Practical Application for SMEs
a business plan. Part III Structure Of The Business Plan will serve the purpose of helping you construct an effective business plan. It will explain why it is important to include certain sections within a business plan, and will also describe how to write them in a manner that is easily comprehensible and gets the message across to the reader.




	Download Free Business Plan Examples
Download a free business plan in PDF or Word doc format to make writing a plan fast and easy Find Your Sample Plan Discover the sample plan that best fits your business. Search our gallery of over 550 sample business plans and find the one that's right for you. View the Gallery What You'll Get:




	PDF The Entrepreneur's Guide to Building a Successful Business
business owners /operators in fourteen countries by Jonathan T. Scott The Entrepreneur's Guide to Building a Successful Business Everything you need to build your successful business: • Finding a profitable business idea • Choosing a location • Writing a business plan • Business model examples • Determining costs and revenues




	Business Plan Development Guide
Chapter 1 - Developing a Business Plan. Chapter 2 - Essential Initial Research. Chapter 3 - Business Models. Chapter 4 - Initial Business Plan Draft. Chapter 5 - Making the Business Plan Realistic. Chapter 6 - Making the Plan Appeal to Stakeholders and Desirable to the Entrepreneur. Chapter 7 - Finishing the Business Plan.




	PDF Business Plan Guide for pdf
Business Plan Guide for pdf MASSACHUSETTS SMALL BUSINESS DEVELOPMENT CENTER NETWORK BUSINESS PLAN GUIDE A structured guide with worksheets to assist you in the development of your business plan, financial projections, and operating budget. Adapted from materials written by Donald J. Reilly




	How To Write A Business Plan (2024 Guide)
Describe Your Services or Products. The business plan should have a section that explains the services or products that you're offering. This is the part where you can also describe how they fit ...




	How to Write a Business Plan, Step by Step
7. Perform a business financial analysis. 8. Make financial projections. 9. Add additional information to an appendix. Business plan tips and resources. MORE LIKE THIS Small-Business Loans Small ...




	PDF Business Plan for a Startup or Existing Business
A business plan consists of a narrative description and financial projections. The narrative description is the body of the business plan. The sections of a business plan can be completed in any order you wish, except for the Executive Summary, which should be completed last but placed at the front of the document.




	PDF GUIDE TO BUSINESS PLANNING
a business plan are; how they read it; and what things different members of the audience will be looking for. The task of writing a business plan is a lot easier if you have a template that can be tailored to the specific needs of your business. Chapter 2 provides one. Also explained is how to design and present a business plan to maximise the ...




	PDF Writing a Business Plan
A Business Plan helps you evaluate the feasibility of a new business idea in an objective, critical, and unemotional way. • Marketing - Is there a market? How much can you sell? • Management - Does the management team have the skill? • Financial - Can the business make a profit?




	10-part business plan template and how write a business plan
Once you've got your audience in mind, you can start your business plan, which should include: 1. Executive summary. Even though it appears first in the official plan, write this section last so you can condense essential ideas from the other nine sections. For now, leave it as a placeholder.




	1.1: Chapter 1
Make certain all of your pages are ordered and numbered correctly. 4. The usual business plan convention is to number all major sections and subsections within your plan using the format as follows: 1. First main heading. 1.1 First subheading under the first main heading. 1.1.1.




	Free editable and printable business plan templates
Document by Ubara. Startup Business Plan in Cream Black and White Modern Sophisticated Style. Document by Canva Creative Studio. Green and White Modern Business Plan Cover Page. Document by Magic Power. Orange Grey Professional Business Plan Cover. Document by Ubara. Brown and White Modern Restaurant Business Plan Document. Document by Morp.




	How to Write a Food and Beverage Business Plan + Sample Business Plan PDF
That's why we recommend you write a business plan. Why write a food and beverage business plan? Writing a business plan is an easy first step that you can start for free. Plus, businesses that take time to plan are significantly more successful than those that don't. Many food and beverage establishments fail because of one of the following:




	Orthopedic Clinic Business Plan PDF Example
Whether you're an experienced entrepreneur or new to the healthcare industry, this guide, complete with a business plan example, lays the groundwork for turning your orthopedic clinic concept into reality. Let's dive in! The Plan. Our orthopedic clinic business plan is structured to encompass all vital elements necessary for a robust strategy.




	30 Emerging Technologies That Will Guide Your Business Decisions
This theme focuses on making the right business and ethical choices in the adoption of AI and using AI design principles that will benefit people and society.. Human-centered AI (HCAI) is a common AI design principle that calls for AI to continuously benefit from human input. Behavioral analytics refers to session-tracking capabilities that monitor user interactions with a protected service to ...




	Create a form in Word that users can complete or print
Show the Developer tab. If the developer tab isn't displayed in the ribbon, see Show the Developer tab.. Open a template or use a blank document. To create a form in Word that others can fill out, start with a template or document and add content controls.




	What Is an MBA? About the Degree, Programs, Jobs, and More
A Master of Business Administration, or MBA degree, is a graduate-level business and management degree with a focus on leadership and managerial skills. By earning this degree, you can equip yourself with the skills and knowledge to accelerate your career, transition to new industries, or even launch your own businesses.
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